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ORGANIZATION OF THE USER GUIDE

The Progress Monitoring and Reporting Network (PMRN) users at the district and school levels are
provided a User Guide organized for both general information and quick reference.

Both the District and School User Guides contain two major parts:

PART I. The PMRN Application
Includes About PMRN, Technical Requirements, Access Levels, Login and Parts of the
Screen

m PART Il. PMRN Daily Reference
| Step by step for common operations, such as enrolling students, registering schools and

creating Student, Teacher, Class and District Reports?

WHERE — Navigation location of this PMRN option

WHO — PMRN access levels permitted to access a particular feature

HOW - Step-by-step instructions for PMRN processes

PART |I. THE PMRN APPLICATION

About the System

Overview

The Florida Department of Education (FDOE) PMRN system is utilized by district- and school-level

administrators and teachers to administer the Florida Assessments for Instruction in Reading — Aligned
to the Florida Standards (FAIR-FS) on the 3-12 Web-Assessment Module (3-12 WAM). Additionally,
the PMRN system provides:

1. access to various reports to monitor student progress in grades 3-12

2. historical data for the 2014-2016 Florida Kindergarten Readiness Screener — Work Sampling
System (FLKRS-WSS).

1 Note that all student, teacher, class and school information (name, FLEID, ID, email, location, school name, etc.) found within this User
Guide was created for educational and illustrative purposes only. Any similarity to actual persons or locations is purely coincidental.
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PMRN Hardware & Connection Requirements

The table below contains the browser and client/software specifications recommended for optimal use
of the PMRN system.

Recommended Bandwidth Specifications

Type Speed

External Connection to Internet 100 kbps per student or faster

Internal School Network 1000 kbps per student or faster

Desktop, Laptop, Netbook & Thin Client / Virtual Desktop Infrastructure

Element Version Recommended Specifications
Operating System Windows Windows 7, Windows 8.1, Windows 10
0S X/ macOS 0OS X 10.11.4 (El Capitan) or newer, tested through High
Sierra
Chrome OS Chrome OS 53 or newer
Memory 1 GB RAM or greater
Connectivity Wired or Wireless Computers must be able to connect to the Internet
Screen Size 9.5 inch screen size or larger
Screen Resolution 1024 x 768 resolution or higher
Output Sound Sound must be enabled.
Input Device Keyboard The input device must allow students to:
Requirements Mouse Select/deselect, drag and highlight text, objects and areas,

enter letters, numbers and symbols and use Shift, Tab,
Enter, Backspace and Delete.

Bluetooth (Pairing) To meet security guidelines, each Bluetooth/wireless
keyboard and/or mouse must be configured to pair with
only a single computer during assessment administration.

Headphones/Earphones Headphones are required for the FAIR-FS for all
students.

Microphone Some student accommodations may require
headphone/microphone equipment in order to enable
speech to text input and/or text to speech output.
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Supported Web Browsers by Operating System for the FAIR-FS

Operating System Browser Version
(or newer)
Windows 7 Chrome 67.0.3396.87
Firefox 60.0.2
Internet Explorer (IE) 11.0.96.19
Windows 8 Chrome 67.0.3396.87
Firefox 60.0.2
Internet Explorer (IE) 11.0.96
Windows 10 Chrome 67.0.3396.99
Firefox 61.0
Internet Explorer (IE) 11.371.16299.0
Edge 41.16299.371.0
0S X/ macOS Safari 11.1.2 (13605.3.8)
Chrome 67.0.3396.99
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Survey 8 Data

The Education Information and Accountability Services (EIAS) Office processes initial files daily at 8:00

a.m. and batch updates files at 4:00 p.m. on Thursday due dates. Import of statewide data into the

PMRN will take place on Friday evenings. The latest Survey 8 data is available in the PMRN system on

Mondays during the submission period.

Survey 8 data submitted by the school district automatically populates class rosters and student data in

the PMRN system.

M Thursday DUE DATES (by 4:00 p.m. EST) starting July 23, 2020 ending September 24, 2020

B Friday DATA IMPORT TO THE PMRN SYSTEM (PMRN offline Friday evenings for import)

B Monday DATA AVAILABLE IN THE PMRN SYSTEM

JULY 2020
M T W TH F

1 2 3
6 7 8 9 10
13 14 15 16 17
20 21 22 23 24
27 28 29 30 31

s s
4 5
11 12
18 19
25 26

M

3

10
17
24
31

AUGUST 2020

T W TH F

4 5 6 7
11 12 13 14
18 19 20 21
25 26 27 28
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Assessment Calendar

All School user access levels may view the important PMRN dates for the FAIR-FS 3-12 WAM.
Login > SCHOOL Functions tile [> School Reports tab [> Assessment Calendar
The PMRN Assessment Calendar lists important dates for the WAM:

School Teacher Class Student  Users  Classes/  Students  Survey Access
CETNT O | Reports | Reports | Reports Periods Status  WAM Key

Assessment Calendar

This report shows this school's calendar(s) as implemented in the PMRN.
Note: Dates specified may change without prior notice. Please check the calendar periodically.

PMRN Important Dates

WAM Important Dates
AP1 Start Date: July 9, 2020

AP1 End Date: November 6, 2020

AP2 Start Date: November 9, 2020
AP2 End Date: February 12, 2021

AP3 Start Date: February 15, 2021
AP3 End Date: June 11, 2021

The FAIR-FS 3-12 WAM assesses students in grades 3-12 three times a year. The assessment periods
(AP1, AP2 and AP3) for the FAIR-FS 3-12 WAM are fixed dates for all schools statewide.

The 2020-2021 assessment periods are:

START DATE First Day of School 11/9/2020 2/15/2021
L L L 2
END DATE 11/6/2020 2/12/2021 6/11/2021
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PMRN System District Access Levels

The user’s assigned access level and location determine the functionality available in the PMRN system.
Important features dependent upon access level include:

e Menu choice availability

e Home Screen tile display

e Tab availability within function tile selections

e Report availability

e User creation and access level modification authority

District Access Levels
There are three district access levels: District Administrator, District Designee and District User.

District Administrator

The District Administrator access level is automatically granted with an FDOE SSO account authorization
provided by the School District IT office. The School District Superintendent is typically the District
Administrator. The District Administrator may view district reports, add new district-level users, add or
remove District Designee and District User access levels, register schools, manage school users, manage
classes/periods, manage students (including the ability to identify students for the Modified Task Flow
and modify student demographics such as first name, last name, date of birth, gender and grade level),
view Survey 8 status and access daily WAM Keys.

District Designee

The School District Assessment Coordinator and/or reading contacts responsible for coordinating the
FAIR-FS administration are typically provided with the District Designee access level. This access level
provides the same features as the District Administrator; however, this access level can only assign the
District User access level to other district-level users.

District User

District User access is typically provided by the District Administrator and/or District Designee to
assessment office professionals with view-only needs. District Users may view district, school, teacher
and class reports, daily WAM keys for all schools in the district and Survey 8 registration status.

Note: District-level users may only assign access levels below their own:

e District Administrator may assign District Designee or District User status

e District Designee may assign only District User status
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Task Permission by Access Level

District District District User

Administrator Designee view access only

4] ] M

DISTRICT Access District Reports
Functions

= View District Registration Report

= Download WAM District Missing Score
Report

= Create WAM District Report

= Download District Data File

NIRIE| @ ™

= View WAM School Keys

Manage District Users

= View Current User List

NN NN HE © R

= Modify User Access Level

= Add a New District Designee

= Add a New District User

PMRN School Registrations
Registration

= View Registered Schools

NERNEENERN

= Modify School Registrations

O S S Y S S S N B SN

=

= Register a School

= Add a School Administrator Added via SSO
4]

= Add Schools

&

SCHOOL Access School Reports
Functions

=

= View Assessment Calendar

= Edit School Registration

= Create WAM School Report

= Download WAM School Data File

= Create WAM Missing Score Report

Access Teacher Reports

= Create WAM Teacher Report

= Create WAM Missing Score Report

Access Class Reports

N RNE RO RNE R NERNE SR SRR SRR RN RN
NN AN AEER ™

NSRRI RNE R NE RN SRR

= Create WAM Class Report
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District District District User

Administrator Designee view access only

= Create Task Ability Reports (WRT, VKT,
RCT, SKT)

&
&
=

Access Student Reports

= Create WAM Parent Letter

= Create WAM Student Ability Score Reports
(multi-year)

N © [ B|™

= Create WAM Student Report (current year)

Manage School Users

= View Current User List

= Modify School User Access Level

Manage Classes/Periods

= View Current Class Period List

Add a New Class Period

Add or Remove a Student from a Class
Period

= Move Class Roster(s)

Manage Students

= View Current Students by Grade

= Search the Student Directory

= Enroll a Student

= Withdraw a Student

= Review Student Attributes

= Update Student Attributes

= |dentify Students for Modified Task Flow

= Change Student Grade Level

View Survey 8 Status

= Review Current Import Information

= Search the Import for a Student

= Search the Import for a Teacher

(O X N N € X O O Y N VS SO I R VR R N R
(O N N U X X O O N I S SO I VR R N R

Access WAM Key
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PMRN Login

In your web browser, go to https://pmrn.fldoe.org:

While all Florida districts participate in the FDOE SSO Portal, not all districts have a direct connection.
Consequently, within the PMRN system, public school user login is either unhosted or hosted:

e Unhosted — Public school districts with no direct connection to FDOE SSO Portal; user login is
validated by a separate district login page.

e Hosted — Public school districts with direct connections to FDOE SSO Portal; user login is
validated via SSO.
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UNHOSTED Users

1. From https://pmrn.fldoe.org [> FDOE Single Sign-On section > Log In:

2. Select your School District:

= = = = (e

Hosted Users instructions.
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|
|
|
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Note: If your district does not appear in the list, select SSO Hosted Users [> follow
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3. On District login page, Enter Username and Password [> Sign In:

R

4. On validation, the PMRN system opens.

P M R N Progress Monitoring & Reporting Network v5.1 — District User Guide
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HOSTED Users

1. From https://pmrn.fldoe.org [> FDOE Single Sign-On section > Log In:

2. If your school district is not listed, select SSO Hosted Users:

P M R N Progress Monitoring & Reporting Network v5.1 — District User Guide
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3. Enter Username and Password [> Sign In:

4. On validation, the PMRN system opens.

5. The PMRN system contains official student records. After signing in, users must agree to
adhere to the provisions of the Family Educational Rights and Privacy Act (FERPA) and
Florida laws regarding access to and disclosure of these records. Review [> | agree:

R

Note: Selection of | do not agree returns you to the PMRN main page
(https://pmrn.fldoe.org) but without PMRN system access!

P M R N Progress Monitoring & Reporting Network v5.1 — District User Guide
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6. If your PMRN ID has multiple access levels and/or access to multiple locations per your
Location setting in SSO, a listing of all unique district/school/access level PMRN
combinations opens. Select radio button corresponding to current session access level >
Next:

O

7. Review the News & Information message(s), if any [> Next

8. The PMRN Home page opens.
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Home Page

The Home Page is the key navigation page within the PMRN system. There are three main areas:

o- -0
O

o Menu Bar The Menu Bar contains major navigational links to the PMRN system and
associated resources, including:

Home — Go to the Home page to display Function Tiles
Profile — Edit your contact information

News — Read relevant updates regarding the PMRN system
3-12 WAM — not available for District users

Downloads — Download grade-specific paper and pencil FAIR-FS
assessments for public schools

Resources — Visit the Just Read, Florida! website
WSS Reports — Download District and State FLKRS-WSS reports by Year

Sign Out — Maintain system security by closing your PMRN session

Username & Displays logged-in user and current access level.
Access Level Bar

9 Function Tiles PMRN system sections relevant to the current user and access level. For
District Administrators and Designees function tiles are:
e DISTRICT Functions
e PMRN Registration
e SCHOOL Functions

District User access level does not have access to the PMRN Registration
tile.
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Menu Bar Detail

The menu bar contains major navigational elements of the PMRN system and is located at the top of

the page under the PMRN banner:

Home

Home directs users to the Home Page to display function tiles relevant to the user’s access level:

R

P M R N Progress Monitoring & Reporting Network v5.1 — District User Guide

-0

16



Profile

Profile fields include Title, First and Last Name, Email, Address, City, State, Zip, (Phone) Extension, Phone
and Fax. All users may edit their personal PMRN contact information.

Select Profile [> Edit [> Save to update Profile:

R

17
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News

This page contains current PMRN system updates posted by the FDOE. Examples include imminent
Assessment Period begin and end dates, new report releases and PMRN system feature updates.

Select News [> Review News updates if any [> Next to continue:

R

3-12 WAM

This page is not available to district-level users.
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Downloads
This page contains printable downloads of the paper and pencil FAIR-FS assessments.

Select Downloads > Specify Grade [> Choose individual Download link for Teacher or Student test,
or Download All for both:

R

Note: Paper and pencil versions of the FAIR-FS assessments result in scores with
greatly reduced validity and reliability and should only be used if required by the
student’s IEP or Section 504 plan.

19
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Resources

This page opens a new browser tab for the Just Read, Florida! website where various resources are

available for public schools. Select PMRN for Public Schools or the full link to begin:

WSS Reports

This page offers a direct download of the District and State FLKRS-WSS reports for public schools.

Historical reports are available for the 2014-2015, 2015-2016 and 2016-2017 school years:

R

P M R N Progress Monitoring & Reporting Network v5.1 — District User Guide
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Sign Out

This link ends a PMRN session securely, i.e., ensures that your specific login connection to the PMRN
system is affirmatively closed. This is especially important on shared devices! Protect your login by
signing out at the end of your PMRN session:

User Name & Access Level Detail

The logged-in user’s name and current access level display in the blue bar below the main menu. The
access level in use determines the functionality available within the PMRN system.

If users have more than one access level, Access Level is a hyperlink.

To change access level in the current session, select the Access Level hyperlink:

-
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Select radio button corresponding to the alternate Access Level [> Next:

P M R N Progress Monitoring & Reporting Network v5.1 — District User Guide
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Function Tiles Detail

Tiles populate the Home page according to access level:

Access Level DISTRICT Functions PMRN Registration SCHOOL Functions
District Administrator M 4} 4}
District Designee M %} 4}

District User

view access only

Note: If a PMRN user has multiple access levels and/or locations, keep in mind that
the Function Tile display is matched to the current-session access level. If you are both
District User and District Administrator, for example, you may wish to have a more
simplified Function Tile display. Selecting District User access level will accomplish the
task! To return to the Function Tile display including PMRN Registration tile, click
Access Level hyperlink > choose District Administrator access level.
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DISTRICT Functions Tile

The DISTRICT Functions tile provides access to district-wide reports and features to manage district-
level user tasks such as:

e Viewing and downloading district-wide registration, WAM and Coach’s Log reports and data files:

Report Title Description Update New
Schedule Reports
Available
District Registration List of all registered schools and summary
Report information: registration date, school start Real Time Undate
date, registered by and registered grades by P
school
District Coach’s Log Aggregate report of the information gained
Report from the submission of Coach’s Log hours Historical Reports
(summary of coach activities within named 2015-2016 & 2014-2015
task categories)
WAM District Missing Aggregate report of WAM assessment tasks Weekl Each
Score Report not started (NS), started (S) and completed (C) y
Update Monday
by grade level and school
WAM District Report Aggregate report of FAIR-FS scores by grade Weekly Each
level and school Update Monday
WAM District Text or Student data file including demographics and Weekly Each
CSV File FAIR-FS scores Update Monday
WAM School Keys Alphabetical listing of all district school daily Keys expire each day at
WAM keys by School Number and Name 7:00 p.m. EST

e Deleting and Adding new district users

e Modifying (+/-) user access level(s) for existing district users
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PMRN Registration Tile

Schools must register each school year in order to participate in the PMRN system. The PMRN
Registration tile enables District Administrators and Designees to access all registration-related tasks,
such as:

Reviewing a list of unregistered schools

Completing registrations for unregistered schools, adding demographic information, School Start
Date and Grades to be assessed in the PMRN system

Reviewing school registrations, registration dates, school start dates, original registration author
and grades registered

Adding new public or Department of Juvenile Justice (DJJ) schools to the PMRN system

Note: PMRN registration tasks can also be performed by the principal at each school.
Additional detail provided in the PMRN School User Guide and on the PMRN
Resources page (http://www.fldoe.org/academics/standards/just-read-fl/fair/public-
school.stml), see Overview of Public School Registration PDF.
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SCHOOL Functions Tile

The SCHOOL Functions tile enables all district-level users to create and view reports related to each
school, teacher, class, student, school user, class period, review survey status and obtain school daily
WAM Key(s). Specific SCHOOL Functions tasks include:

Creating school-specific WAM School, Teacher, Class, Student and Missing Score Reports

Report Title Description Update New Reports
Schedule Available
WAM School Aggregate report of WAM assessment scores by Overnight 7.00 a.m. EST
Report school and AP grouped by grade and class period Update ' T
WAM School Text | Data file of WAM assessment scores by school Weekly Each Monda
or CSV File and student including demographic data Update ¥
WAM Missing Aggregate report of current AP WAM assessment Overnight
Score Report task completion by school, grade level, teacher Update
and/or class section in grade and student order Real Time if 7:00 a.m. EST
rosters are in
sync
WAM Teacher Aggregate report of WAM assessment scores by )
. Overnight
Report school, year, AP, teacher and/or class section 7:00 a.m. EST
. Update
grouped by grade and class period
WAM Class Aggregate report of WAM assessment scores by Overnight
Report school, year, AP, grade, teacher and/or class & 7:00 a.m. EST
. . ! Update
section displayed in student order
WRT, VKT, RCT Aggregate report of WAM assessment scores by Overnight
anC_i _SKT Task school, year, AP, grade, teacher and/or class Update
Ability Reports section displayed in descending score order Real Time if 7:00 a.m. EST
rosters are in
sync
WAM Parent Student-specific customizable Parent Letter
Letter populated with FAIR-FS assessment results and Real Time Update
suggested activities
WAM Student Student-specific summary report of (up to) three
Ability Score years’ PLS and FAIR-FS task scores for each AP Real Time Update
Reports
WAM Student Student-specific summary report of one year’s
Report FAIR-FS task ability scores, with date/time Real Time Update
stamp, percentile rank and PLS for specified AP

Managing school users and PMRN access levels

Managing class periods and rosters

Manage student enrollment, demographic attributes and grade level assignment

Accessing the daily WAM Key

P M R N Progress Monitoring & Reporting Network v5.1 — District User Guide
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PART Il. PMRN DAILY REFERENCE

HOME

For District Access Levels:
ALL

Location:
PMRN Home [> User Access Bar

Change Current Access Level Logon

Logged-in User Name and Access Level show in the blue bar below the main Home menu. It is important
to acknowledge the access level in use as this determines the functionality available to the user within

the PMRN system:

If a single user has more than one access level or has access within several districts or schools, Access
Level is a hyperlink. To change access level in the current session:

1. Select the Access Level hyperlink > Select radio button corresponding to the alternate
access level [> Next:

O

S

2. New Access Level displays in the blue User Name and Access Level bar.

— Note: Access Level determines the Home function tiles available to the user, e.g., the
— PMRN Registration tile is available at the District Administrator and District Designee

S levels only.
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Location: For District Access Levels:

PMRN Home > Menu Bar ALL

Update User Profile Information

Any PMRN user may edit his or her profile. Edits may include changes to last name, email address,
physical address, telephone or fax numbers.

1. PMRN Home > Profile

2. Edit information as needed [> Save:

3. “Your profile was successfully updated.” message confirms update.

Note: If your district has changed its email domain, e.g., from address@myschool.org
to address@mydistrict.org and has hundreds of PMRN Profiles to update, consider
contacting the IEN Help Desk via email at IENHELP@fldoe.org or by phone at 855-
814-2876 for assistance.

28
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View News Updates from DOE

The FDOE adds News & Information messages to the PMRN system, such as Assessment Period start
and end dates, PMRN system closure dates and report and download release dates.

1. PMRN Home > News

2. Current updates display:

3. Next to return to the Home page.
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Location: For District Access Levels:
PMRN Home > Menu Bar NONE

Access WAM Manager

The District Administrators, District Designees and District Users do not have sufficient rights to access
the 3-12 WAM menu option and will see only this message if 3-12 WAM is selected:

pmrn.fldoe.org says:

You do not have rights to access this page.

Select OK to dismiss notice.

Note: The 3-12 WAM link is available to the following access levels:

e School Administrator

e School Designee
e Reading Teacher
e Resource Teacher

e Assessment Team Member
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Location: For District Access Levels:
PMRN Home > Menu Bar ALL

Download Paper & Pencil FAIR-FS Alternative Assessments

Students requiring a paper and pencil accommodation may be given a printed copy of the FAIR-FS
alternative assessment.

1. PMRN Home [> Downloads
2. Specify Grade

3. Choose individual Download link for teacher copy or student test, or Download All for
both:

R

4. PDFs will download to your browser’s Download folder location.

Note: Alternative assessment scores are not recorded in the PMRN system and are
therefore not available to PMRN progress monitoring activities and reports.
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Access FDOE Online FAIR-FS Resources

The FDOE provides a variety of assessment-related resources on its website for download.

1. PMRN Home [> Resources

2. The Department of Education’s Just Read, Florida! PMRN webpage launches:

R

3. Select PMRN for Public Schools [> See information related to the administration of the
FAIR-FS assessments and PDF links to PMRN Guides.
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Download Historical FLKRS-WSS District Reports

FLKRS-WSS historical reports for 2014-2015, 2015-2016 and 2016-2017 are available for download for
public school users:

1. PMRN Home [> WSS Reports
2. Select School Year > District

3. Choose individual Download link for District Report of Schools, State Results for Public
Schools and/or FLKRS-WSS Report Scoring Table(s):

R

Sign Out Securely

Once all PMRN system operations are complete, affirmatively sign out of the PMRN system for best
security:

1. Sign Out in the top navigation bar to securely exit the PMRN system:

2. “You have signed out. For improved security, we recommend that you close all browser
windows at the end of your online session.” message confirms Logout.

Timeout & Security: If you do not sign out, the PMRN system will automatically log
you out for inactivity in 20 minutes.

If your PMRN session is complete and you simply close the browser window and walk
away, the next user has 20 minutes to open the browser window, resume your
session and keep it active indefinitely assuming no 20-minute periods of inactivity.
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DISTRICT Functions Tile

Location: For District Access Levels:
DISTRICT Functions [> District Reports ALL

View District Registration Report

1. PMRN Home [> DISTRICT Functions tile [> District Reports tab

2. Select a Year [> District Registration Report:

District
Reports

2020-2021 ~

Description
District Registration Report District Schools Registration Report.
WAM District Missing_Score Report 3-12 WAM District Missing Score Report.
WAM District Report 3-12 WAM District Aggregate Report.

WAM District Text File ( Show Text File Format ) CSV File ( Show CSV File Format )  3-12 WAM District Data File (TEXT/CSV Format).

WAM School Keys 3-12 WAM School Daily Keys.

3. Report opens in a new browser window:

FAIR-FS PMRN: Reports

Box Cove Springs JR High Public 07/21/2020 07/08/2020 Sivakumar Injarapu 3456
Darlene Gabo Public 07/21/2020 07/09/2020 Sivakumar Injarapu 3456
Sand Park Junior High School Public 07/22/2020 07/09/2020 Peter Mccabe 6.7.8
Sandbox High School Public 07/M17/2020 07/13/2020 Artesa Anderson 9.10,11,12
Sandburg Junior High Public 07/30/2020 08/10/2020 Joyce Public 6.7.8

Note: Only schools with completed registration display in the District Registration
Report.
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Download WAM District Missing Score Report

1. PMRN Home [> DISTRICT Functions tile > District Reports tab
2. Select a Year [> WAM District Missing Score Report:

District f§ S5
Reports

Select a Year: | 2020-2021 v~
District Registration Report District Schools Registration Report.
I WAM District Missing Score Report I 3-12 WAM District Missing Score Report.
WAM District Report 3-12 WAM District Aggregate Report.

WAM District Text File ( Show Text File Format ) CSV File ( Show CSV File Format )  3-12 WAM District Data File (TEXT/CSV Format).

WAM School Keys 3-12 WAM School Daily Keys.

3. Browser launches a new window > Follow browser-specific instructions to open the file
(CSV)

4. Report contains data for current year, current AP:

A B C D E F G H | J K L M N (o]

1 |SchoollD  SchoolName GradelD WRT_NS WRT_S WRT_C VKT_NSVKT_S VKT_C RCT_NSRCT_S RCT_C SKT_NS SKT_S SKT_C
2 1056842 Sandbox High School 9 10 1 2 11 1 1 12 0 1 12 0 1
3 1056842 Sandbox High School 10 9 0 1 9 0 1 9 0 1 9 1 0
4 1056842 Sandbox High School 11 10 0 1 10 1 0 11 0 0 11 0 0
5 1056842 Sandbox High School 12 16 0 0 16 0 0 16 0 0 16 0 0
6 1306836 Sand Park Junior High School 6 4 0 11 4 0 11 4 1 10 11 0 4
T 1306836 Sand Park Junior High School 7 8 0 6 8 0 6 8 0 6 9 1 4
8 1306836 Sand Park Junior High School 8 14 0 0 14 0 0 14 0 0 14 0 0
o

Prior year reports contain data for AP3 of selected year only.
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Create WAM District Report

1. PMRN Home [> DISTRICT Functions tile > District Reports tab
2. Select a Year > WAM District Report:

District
Reports

2020-2021 ~

District Registration Report District Schools Registration Report.
WAM District Missing Score Report 3-12 WAM District Missing Score Report.
WAM District Report 3-12 WAM District Aggregate Report.

WAM District Text File ( Show Text File Format ) CSV File ( Show CSV File Format )  3-12 WAM District Data File (TEXT/CSV Format).

WAM School Keys 3-12 WAM School Daily Keys.

3. Report window launches > Use the Active Header Menu drop-downs to select School
Year and AP [> Show Report:

FAIR-FS PMRN: Reports

Other than FL Put ~ All e 2020 - 2021

KN

No Item Available v

Show Report
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5. Report is organized by Grade Summary. Expand/collapse using the +/- button to the left of
each Grade Summary to show school detail:
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Download the WAM District Data File & Data File Format (TXT or CSV)

1. PMRN Home [> DISTRICT Functions tile > District Reports tab
2. Select a Year > WAM District Text File & ( Show Text File Format ) or

CSV File & ( Show CSV File Format ):

Select a Year: | 2020-2021 ~

District Registration Report District Schools Registration Report.
WAM District Missing_Score Report 3-12 WAM District Missing Score Report.
WAM District Report 3-12 WAM District Aggregate Report.

WAM District Text File ( Show Text File Format ) CSV File ( Show CSV File Format ) I 3-12 WAM District Data File (TEXT/CSV Format).

WAM School Keys 3-12 WAM School Daily Keys.

a. Data File — WAM District Text File or CSV File > new window launches > Follow
browser-specific instructions to open the file
b. Data File Formats — ( Show Text File Format ) or ( Show CSV File Format ); these files

describe each field, file position, field type and acceptable values for each:

i.  (Show Text File Format) [> PDF launches in a new window:
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ii. (Show CSV File Format) > PDF launches in a new window:
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View All District WAM School Keys

1. PMRN Home [> DISTRICT Functions tile > District Reports tab
2. Confirm current Year [> WAM School Keys:

District f§ S5

Reports
Select a Year: | 2020-2021 v~
District Registration Report District Schools Registration Report.
WAM District Missing_Score Report 3-12 WAM District Missing Score Report.
WAM District Report 3-12 WAM District Aggregate Report.
WAM District Text File ( Show Text File Format ) CSV File ( Show CSV File Format )  3-12 WAM District Data File (TEXT/CSV Format).
WAM School Keys 3-12 WAM School Daily Keys.

3. Report opens in a new window to display a list of all district schools to show School
Number, School Name and current WAM Key

4. Click to Print.

Note: Reading teachers and other non-administrative school users may generate a
WAM Key for a specific school using Menu > 3-12 WAM [> Generate Key.
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Location: For District Access Levels:
DISTRICT Functions > Users ALL

View Current User List

1. PMRN Home [> DISTRICT Functions tile > Users tab:

District
Reports

Sort by User Name or Access Level. Click a User Name to edit that User. AddUSer |
User PMRN Unique Id Access Level
Ainslee, Bart SAMPLEO1 District Administrator
Grant, David SAMPLEOZ2 District Administrator
Grant, David SAMPLEOZ District User
Inge, Sarah SAMPLEO3 District Administrator
Inge, Sarah SAMPLEO3 District User
Public, Joyce SAMPLEO4 District Administrator
Public, Joyce SAMPLEO4 District Designee
Public, Joyce SAMPLEO4 District User

View Individual District User Detail

2. Fromthe Users tab > Choose User name [> Review PMRN Unique ID, First Name, Last
Name, Email and Access Level(s):

District
Reports.

PMRN Unique ID SAMPLEO4

Identifier * e

First Name * Joyce

Last Name * Public

E-mail * Joyce Public@fldoe.org

Access
Allow? Access Level Access to PMRN

District Designee

District User

Submit Cancel

* Denotes required fields.
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Modify User Access Level

3. From the Users tab [> User Record, see Access section. Specify Access:

a. Check box(es) to Add Allow? > Submit > “You have changed this User’s
information. Please verify that the information below is correct.” message appears
[> Review and Continue > “User information was updated successfully.” message
confirms [> Verify in the Users tab

b. Uncheck box(es) to Remove Allow? > Submit [> “You have changed this User’s
information. Please verify that the information below is correct.” message appears
[> Review and Continue > “User information was updated successfully.” message
confirms > Verify in the Users tab

Note: A single access level must have both Allow? and Access to PMRN checked in
order to enable the PMRN system user.

Delete a District User

4. Uncheck ALL Allow? checkboxes > Submit:

Access

Allow? Access Level Access to PMRN

District Administrator
District Designee

District User

]

5. “You have removed the last access level from this User. Continuing this action will
delete this User.” message appears [> Review and Continue to confirm [> “User
information was updated successfully.” message confirms

6. Verify that the user no longer appears in the Users tab.
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Location:
DISTRICT Functions > Users

For District Access Levels:
District Administrator
District Designee

Add a New District User

1. PMRN Home [> DISTRICT Functions tile > Users tab

2. Add User:

Sort by User Name or Access Level. Click a User Name to edit that User.

PMRN Unique Id

Abbott, Carey ASAMPLEOL

Dean, Forrest ASAMPLEDZ

Filter By: | All

District
Reports

v

Access Level
District User

District Administrator

Add User

3

3. Enter ID, First Name, Last Name, Email or Identifier information [> Search

4. Confirm user information > Select corresponding radio button > Add SSO User:

O

R

5. Choose Allow? checkboxes to add Access Level(s) > Submit > “You have changed this
User’s information. Please verify that the information below is correct.” message
appears [> Review and Continue > “User information was updated successfully.”

message confirms

6. Verify in the Users tab.
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PMRN Registration Tile

Overview

District-level users with a District Administrator or District Designee access level have a PMRN
Registration tile that provides access to lists of all registered and unregistered schools and features to
manage school registration tasks such as modifying existing school registrations, completing registration
of unregistered schools and adding schools to the PMRN system as needed. School registration allows
administrators to specify the school start date and grades to include in FAIR-FS testing and Survey 8
updates.

Tasks by Access Level

District District District
Administrator Designee
PMRN Register Schools %} ™
Registration Edit School Registrations %} ™
Add Schools | ™

P M R N Progress Monitoring & Reporting Network v5.1 — District User Guide 44



Location: For District Access Levels:
PMRN Registration [> Registered Schools District Administrator
District Designee

View a List of Registered Schools

1. PMRN Home [> PMRN Registration tile:

2. Registered Schools tab:

Unregistered BTG50 Add
Schools Schools Schools

School Number Registration Date School Start Date Registered By Registered Grades

Box Cove Springs JR High 990021 07/21/2020 07/08/2020 SIVAKUMAR INJARAPU 3,4,5,6
Darlene Gabo 999907 07/21/2020 07/09/2020 SIVAKUMAR INJARAPU 3,456
Sand Park Junior High School 990361 07/22/2020 07/09/2020 Peter Mccabe 6,7,8
Sandbox High School 990341 07/17/2020 07/13/2020 Artesa Anderson 9,10,11,12
Sandburg_Junior High 990391 07/30/2020 08/10/2020 Joyce Public 6,7,8

Modify a School Registration

1. PMRN Home [> PMRN Registration tile [> Registered Schools tab

2. Choose School Name [> The FAIR-FS School Registration form opens. Note that the
form is divided into five sections:

a. School Information — To modify this information, contact IENHelpDesk.

b. School Administrator(s) — This information cannot be modified within this form.
Following completed school registration, complete Add a School Administrator
instructions to add or go to SCHOOL Functions tile [> Users tab to modify the existing
administrator(s).
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c. School Start Date (First Student Instructional Day) — Enter and confirm the first
instructional date of the School Year.

d. Grades to be Assessed — Check to add grades or uncheck to remove grades for the
FAIR-FS testing > Yes or No for students to be updated by Survey 2 & 3.

e. Acknowledgement — Check box to acknowledge.

3. Submit

4. A verification screen opens when submission is error-free [> Review:

a. To modify > Back.
b. To finalize registration [> Save.

i.  “Thank you for registering to use the PMRN system for the 2020-2021 school
year. A confirmation will be sent to your email. Click Continue to return to the
home page.” message confirms > Continue:

c. To exit without saving [> Cancel.
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Location: For District Access Levels:

PMRN Registration > Unregistered Schools District Administrator
District Designee

Register a School

1. PMRN Home [> PMRN Registration tile [> Unregistered Schools tab:

LINTENTE S | Registered Add
Schools Schools Schools

k_

School Name School Number

Bay Breeze Elementary 991001

Gulf Breeze High School 999002
Sandburg Junior High 990391
999018

Tall Pines Middle School

2. Choose School Name of unregistered school [> the School Registration form opens. Note
that the form is divided into five sections:

a. School Information:

School Name, Number, District, Address, Phone and Fax are preloaded from the
FDOE Master School Identification (MSID) file.

ii. Review > Contact IEN HelpDesk (email or 855-814-2876) to modify.
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b. School Administrator(s):

Name: Joyce Public
Name: Peter Mccabe
Name: Margaret Begin

2. School Administrator(s)

Current users with the school administrator access level are listed below.

Name: Jerry Christoph
Name: Rithan Chanra
Name: Amy Hand

Note: After registration is submitted, access levels may be modified via the school's Users tab.

Users with School Administrator access level are listed. If no School Administrator
is specified, complete the school registration process. Following completed
registration, complete Add a School Administrator instructions.

c. School Start Date:

08 Js [0
* Confirm School Start Date (mmiddyy) :  [08 |/ [10 |/

* School Start Date  (mmiddiyy) :

i.  Enter School Start Date (First Student Instructional Day) > Re-enter to
confirm.

d. Grades to be Assessed:

4. Grades to be Assessed

Select the grade level(s) that will be assessed. Please note, student enrollment information may be imported and manually added into the PMRN
system. To have student enrollment information imported into the PMRN system, the school district must submit Survey & data during the specified
window (July to September). Student enroliment information may be updated with Survey 2 data (November) and Survey 3 data (March) if selected
below.

A. Grades 3-12: The FAIR-FS is available to assess students in grades 3-12 once per assessment period to monitor reading progress.

Students Updated by Surveys 2 & 37 (Survey 8 Required)

[ Third Grade Yes No
[CJFourth Grade Yes No
[JFifth Grade Yes No
Sixth Grade ONo
Seventh Grade ONo
Eighth Grade ONo
[JNinth Grade Yes No
[JTenth Grade Yes No
[CJEleventh Grade Yes No
[ Twelfth Grade Yes No

i. Check box(es) to enable the FAIR-FS assessment for selected grades

ii. Select Yes or No for students to be updated by Survey 2 & 3.
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e. Acknowledgement:

5. Acknowledgement

* | understand the school district Information Systems Office must be notified to submit student information, responsible instructer of reading and
staff information to the FDOE during the Survey 8 window in order to initiate the automatic import. Updates based on Surveys 2 & 3 can only
occur when Survey 8 data has been submitted by the school district.

Submit

%

i.  Check boxto acknowledge
3. Submit

4. A verification screen opens when submission is error-free [> Review:

R
a. Tomodify [> Back.

b. To finalize registration [> Save.

i.  “Thank you for registering to use the PMRN system for the 2020-2021 school
year. A confirmation will be sent to your email. Click Continue to return to the
home page.” message confirms > Continue.

c. To exit without saving [> Cancel.
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Location: For District Access Levels:
SCHOOL Functions [> Users District Administrator
District Designee

AddaSchool Administrator

If, during school registration, you noted a lack of any designated School Administrators, add at least one
for best results:

1. When registration is complete, new School Administrator access must be granted from the
SCHOOL Functions tile [> Users tab

2. Select Username to open user record > See Access section. Note two columns of
checkboxes: Allow? and Access to PMRN. Both checkboxes must be checked to enable an
individual access level.

3. On the School Administrator access level row, click to check Allow? box, confirm that
Access to PMRN box is checked (and if not, check it!) > Submit

4. "You have changed this User’s information. Please verify that the information below is
correct.” message appears > Review and Continue

5. “User information was updated successfully.” message confirms

6. Verify in the Users tab.
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Location: For District Access Levels:
PMRN Registration > Add Schools District Administrator

District Designee

AddSchoolstotheDistrict

A school must be added to the list of schools in the PMRN system prior to registration. Check the
Unregistered Schools and Registered Schools tabs to determine whether a school is in the PMRN

system.
1. PMRN Home [> PMRN Registration tile [> Add Schools tab
2. Select School Type > School Name [> select School
3. Complete required fields [> Submit:

DS

g\

4. “New School added successfully.” message confirms successful add

5. Unregistered Schools tab > Select School Name

6. Complete Register a School steps.
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SCHOOL Functions Tile

Overview

The SCHOOL Functions tile provides access to each school within the district. This includes access to
school-level Teacher, Class and Student Reports tabs. It also includes features to manage school-level
tasks such as assigning access levels to users, managing classes/periods, managing students, viewing
Survey 8 data import status and accessing the daily school WAM Key. While district-level users can
perform school-level tasks, these tasks can also be performed by school administrators and school
designees.

Tab Display Differences

District Administrator and District Designee access levels:

User: Joyce Public | Access Level: District Administrator

Other Than Florida Public Sch

District User access level:
User: Joyce Public | Access Level: District User

Other Than Florida Public Sch
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Location: For District Access Levels:
SCHOOL Functions > School Reports ALL (if view or create)
District Administrator (if edit)

District Designee (if edit)

View Assessment Calendar

1. PMRN Home [> SCHOOL Functions tile > School Reports tab

2. Select a Year > School [> Assessment Calendar:

2020-2021 ~
Sand Park Junior High School v

Assessment Calendar

. Edit School Registration
WAM School Report
WAM School Text File ( Show Text File Fermat ) CSV File { Show CSV File Format )

WAM Missing_Score Report

3. PMRN Important Dates for WAM are displayed:

Assessment Calendar

This report shows this school's calendar(s) as implemented in the PMRN.
Note: Dates specified may change without prior notice. Please check the calendar periodically.

PMRN Important Dates

WAM Important Dates
AP1 Start Date: July 9, 2020
AP1 End Date: November 6, 2020

AP2 Start Date: November 9, 2020
AP2 End Date: February 12, 2021

AP3 Start Date: February 15, 2021
AP3 End Date: June 11, 2021
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Edit School Registration

1. PMRN Home [> SCHOOL Functions tile > School Reports tab
2. Select a Year [> School > Edit School Registration:

School Teacher Class Student  Users Classes/ Students  Survey Access
[[T%7 5N | Reports | Reports | Reports Periods Status ~ WAM Key

Select a Year: (2020-2021 v~

Select a School: | Sand Park Junior High School v |

Assessment Calendar
Edit School Registration
WAM School Report

WAM School Text File ( Show Text File Fermat ) CSV File { Show CSV File Format )

WAM Missing Score Report

3. The FAIR-FS School Registration form opens. Note that the form is divided into five
sections:

a. School Information — To modify this information, contact IENHelpDesk.

b. School Administrator(s) — To modify this information, complete the form and return to
the SCHOOL Functions tile [> Users tab to grant School Administrator access.

o

School Start Date (First Student Instructional Day) — Modify and confirm the first
instructional date of the School Year.

d. Grades to be Assessed — Check box(es) to enable the FAIR-FS assessment for selected
grades or uncheck to disable [> Yes or No for students to be updated by Survey 2 & 3.

e. Acknowledgement — Check box to acknowledge.

4. Submit

5. A verification screen opens when submission is error-free [> Review
a. To modify > Back.
b. To finalize registration [> Save.

i.  “Thank you for registering to use the PMRN system for the 2020-2021 school
year. A confirmation will be sent to your email. Click Continue to return to the
home page.” message confirms [> Continue.

o

To exit without saving > Cancel.

Note: Editing school registrations is limited to District Administrators, District
Designees and School Administrators with Principal designation.
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Create WAM School Report

1. PMRN Home [> SCHOOL Functions tile > School Reports tab
2. Select a Year [> School > WAM School Report:

2020-2021 ~
Sand Park Junior High School v

Assessment Calendar

_Edit schoal Registration
WAM School Report I

L
WAM School Text File ( Show Text File Format ) CSV File ( Show CSV File Format )

WAM Missing_Score Report

3. Report window launches > Use the Active Header Menu drop-downs to select School,
School Year, Calendar and AP > Show Report:

FAIR-FS PMRN: Reports

Other than FL Put v Sand Park Junior| 2020 - 2021
District-Wide: -

All v

Show Report

Note Click to Print and Show Legend hyperlinks.
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4. Reportis organized by Grade Summary. Expand/collapse grades to show class period detail
using +/- button to the left of each Grade Summary:

Download WAM School Data File

1. PMRN Home [> SCHOOL Functions tile > School Reports tab

2. Select a Year > School > WAM School Text File & ( Show Text File Format ) or
CSV File & ( Show CSV File Format ):

School Teacher Class Student  Users Classes/ Students  Survey Access
[[T5%7.50  Reports | Reports = Reports Periods Status ~ WAM Key

Select a Year: |2020-2021 «

Select a School: |Sand Park Junior High School v |

Assessment Calendar
Edit School Registration

WAM School RePo_r't
I WAM School Text File ( Show Text File Format ) CSV File { Show CSV File Format ) I

WAM Missing_Score Report

a. Data File - WAM School Text File or CSV File > new window launches [> Follow
browser-specific instructions to open the file
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b. Data File Description — ( Show Text File Format ) or ( Show CSV File Format ); these
files describe each field, file position, field type and field acceptable values for each
filetype

i.  (Show Text File Format) > PDF launches in a new window:

ii. (Show CSV File Format) > PDF launches in a new window:
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Create WAM Missing Score Report

1. PMRN Home [> SCHOOL Functions tile > School Reports tab
2. Select a Year [> School > WAM Missing Score Report:

2020-2021 ~
Sand Park Junior High School v

Assessment Calendar

Edit School Registration

WAM School Report
WAM School Text File ( Show Text File Format ) CSV File ( Show CSV File Format )
————

WAM Missing_Score Report

3. Report window launches > Use the Active Header Menu drop-downs to select School,
Calendar, Grade Range, Teacher and Class-Section > Show Report:

FAIR-FS PMRN: Reports

Other than FL Put v Sand Park Junior| 2020 - 2021 ~
District-Wide 7th Grade

7, Carter, Yolanda 07 - Carter, Yola Al v

Show Report

W

Note Click to Print and Show Legend hyperlinks.
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4. Report displays task completion for the current year and AP:

of YoI Y I' Y Jolol

Grade ID FLEID StudentName WRT VKT R
7 TDO00D00915882 Jeffers, Amelia O O
7 TDO00000202813 Jefferson, Katria (@) O
7 TDO00D00869909 Kincaid, Nia [ ] @
7 TDO000007 15248 Marin, Jill [ ] [ ]
7 0000001921933 Maximillian, Homer [ ] ®
7 TDO00000513049 Miller, Katherine [ ] [ ]
7 TDO00000861101 Morehead, Alanna O O
7 TDO00000710209 Mosel, Kathy [ ] [ ]
7 TDO00D00T53652 OBrien, Shay O O

Missing Score Report Key

I
~
i
~
o
~

WRT Word Recognition Task

VKT Vocabulary Knowledge Task
RCT Reading Comprehension Task
SKT Syntactic Knowledge Task
ORT Open Response Task

Task Complete

Task Not Started

Task Started, Incomplete
Task Not Applicable

2®O
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Location: For District Access Levels:
SCHOOL Functions > Teacher Reports ALL

Create WAM Teacher Report

1. PMRN Home [> SCHOOL Functions tile [> Teacher Reports tab
2. Select a Year [> School > WAM Teacher Report:

Teacher
Reports

2020-2021 ~

Sand Park Junior High School v

Report Description

WAM Teacher Report 3-12 WAM Teacher report.

WAM Missing_Score Report 3-12 WAM Assessments Missing Score Report.

3. Report window launches > Use the Active Header Menu drop-downs to select School,
School Year, Calendar, AP, Teacher and/or Class-Section > Show Report:

FAIR-FS PMRN: Reports

Other than FL Put v Sand Park Junior| 2020 - 2021

District-Wide

&, Carter. Yolandd

Note Click to Print and Show Legend hyperlinks.
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4. Report is organized by Grade Summary. Expand/collapse grade(s) to show class section
detail using +/- button to the left of each Grade Summary:

Create WAM Missing Score Report

1. PMRN Home [> SCHOOL Functions tile [> Teacher Reports tab
2. Select a Year > School > WAM Missing Score Report:

I Reports | I I I I |
Reports

2020-2021 »

Sand Park Junior High School v

Report Description
WAM Teacher Report 3-12 WAM Teacher report. '
WAM Missing _Score Report 3-12 WAM Assessments Missing Score Report.

3. Report window launches > Use the Active Header Menu drop-downs to select School,
Calendar, Grade Range, Teacher and Class-Section > Show Report:

FAIR-FS PMRN: Reports

Other than FL Put v Sand Park Junior| 2020 - 2021 ~
Districi-Wide 7th Grade
7, Carter, Yoland 07 - Carter, Yola All ~

Show Report

W

Note Click to Print and Show Legend hyperlinks.
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4. Report displays task completion for the current year and AP:

Grade ID FLEID StudentName WRT VKT RCT SKT ORT
7 TD000000915882 Jeffers, Amelia O O O
7 TDO00000202813 Jefferson, Katria O O O
7 TDO00000869909 Kincaid, Nia [ ] [ ] [ ] [ ]
7 TDO00000T15248 Marin, Jil [ ] [ ] o
7 TDO0D001921933 Maximillian, Homer [ ] [ ] [ ] [ ]
7 TDO00000513049 WMiller, Katherine [ ] [ ] [ ] [ ]
7 TD000000BB1101 Morehead, Alanna O O O
7 TDO00000T10209 Mosel, Kathy [ ] [ ] [ ] [ ] [ ]
7 TDO00000T53652 OBrien, Shay O O O

Missing Score Report Key

WRT Word Recognition Task

VKT Vocabulary Knowledge Task

RCT Reading Comprehension Task

SKT Syntactic Knowledge Task

ORT Open Response Task

[ ] Task Complete

@) Task Not Started

O Task Started, Incomplete

@ Task Not Applicable

Location: For District Access Levels:
SCHOOL Functions > Class Reports ALL

Create WAM Class Report

1. PMRN Home [> SCHOOL Functions tile > Class Reports tab
2. Select a Year > School [> WAM Class Report:

School  Teacher Class Student Users Classes/ Students Survey Access
Reports | Reports W07, C8  Reports Periods Status  WAM Key

Select a Year: 2020-2021 v

Select a School: | Sand Park Junior High School v |

Report Description
3-12 WAM Class report.
WRT Ability Word Recognition Task (WRT) Ability.
VKT Ability Vocabulary Knowledge Task (VKT) Ability.
RCT Ability Reading Comprehension Task (RCT) Ability.
SKT Ability Syntactic Knowledge Task (SKT) Ability.
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3. Report window launches > Use the Active Header Menu drop-downs to select School,
School Year, Calendar, AP, Grade Range, Teacher and Class-Section > Show Report:

FAIR-FS PMRN: Reports

Other than FL Put v Sand Park Junior 2020 - 2021
District-Wide 6th Grade

6, Carter, Yolands 06 - Carter, Yola

Show Report

WS

Note Click to Print and Show Legend hyperlinks
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4. Report displays student Probability of Literacy Success (PLS), Percentile Ranks and Ability
Score data for the selected class section(s), with summary chart and legend:

Probability of Literacy
Clsjcsk E?ﬂe_r Success Percentile Ranks Ability Score
\f ) -
(Click to Sort)
WRT | VKT | RCT | SKT WRT | VKT | RCT | SKT
Jalopnik, Trinity 1000 562 563 769
th ih d i
99 75 72" | o (505) | (504) | (510) | (516)
WRT | VKT | RCT | SKT WRT | VKT | RCT | SKT
Jonas. Miracle A
n i 1000" | 401
99 | 1 (508) | (504)
WRT | VKT | RCT SKT WRT | VKT RCT SKT
Y h th th 1000 727 711
99" 99 98 (505) | (504} | (510)
WRT | VKT | RCT | SKT WRT | VKT | RCT | SKT
Kelly, George 0.38 592 474 458 | 1000"
n th th i
8™ | 36 29 % (505) | (504) | (510) | (516)
WRT | VKT | RCT | SKT WRT | VKT | RCT | SKT
n d th
g9 | 72" | 90 (605) | (504) | (510)
WRT | VKT | RCT | SKT WRT | VKT | RCT | SKT
Kenshaw, Miller _ 1ot ot 4 ogth ov 303 344 752
(505) | (504) | (510) | (516)
WRT | VKT | RCT | SKT WRT | VKT | RCT | SKT
Kilharn. Maon 0.18
n I m 447 | 481 | 383 | 759
26" | a9 9 % (505) | (504) | (510) | (516)
WRT | VKT CT SKT WRT | VKT | RCT SKT
Kollins,_Jared _ 383 A
th th rd 1000" | 650
8% | e | 83 505) | (504) | (510)
43%
Gi
43%
7
Class Report Key Additional Report Information
WRT Word Recognition Task An asterisk(*) - Indicates that the student's score was achieved while the student
VKT Vocabulary Knowledge Task was enrolled in a different school during the selected Assessment Period
ABlank Score - Indicates that the student has not taken any assessments durin
RCT Reading Comprehension Task the selected Assessment Period ’ ¢
SKT Syntactic Knowledge Task Missing PLS Score - A student must complete the RCT task befare the system can
PLS Probability of Literacy Success calculate the PLS

P M R N Progress Monitoring & Reporting Network v5.1 — District User Guide 64



Create Task Ability Reports (WRT, VKT, RCT, SKT)

1. PMRN Home [> SCHOOL Functions tile [> Class Reports tab
2. Select a Year > School [> Task Ability:

2020-2021 ~

Sand Park Junior High School v

WAM Class Report 3-12 WAM Class report.
WRT Ability Word Recognition Task (WRT) Ability.
VKT Ability Vocabulary Knowledge Task (VKT) Ability.

RCT Reading Comprehension Task (RCT) Ability.

SKT Ability Syntactic Knowledge Task (SKT) Ability.

3. Report window launches > Use the Active Header Menu drop-downs to select School,
School Year, Calendar, AP, Grade Range, Teacher and Class-Section > Show Report:

FAIR-FS PMRN: Reports

Other than FL Puk Sand Park Juniof 2020 - 2021
District-Wide 1 6th Grade
6, Carter, Yolandg 06 - Carter, Yola All v

Show Report

W

Note Click to Print and Show Legend hyperlinks.

4. Report displays student (RCT) Task Ability Scores in descending score order:
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Location: For District Access Levels:
SCHOOL Functions [> Student Reports ALL

Create WAM Parent Letter

1. PMRN Home [> SCHOOL Functions tile [> Student Reports tab
2. Select a Year [> School > Grade [> Student [> WAM Parent Letter:

Student
Reports

2020-2021 v

Sand Park Junior High School v
KENSHAW, MILLER »

Report Description
WAM Parent Letter Generate parent letter for current year.

WAM Student Ability Score Reports Generate 3-12 WAM Student Ability Score Reports for multiple years.

WAM Student Report Generate 3-12 WAM Student Report for current year.

3. Report window launches > Use drop-downs and checkboxes to customize the WAM
letter [> Enter additional comments in the box provided [> Preview Report
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4. Customized letter opens in a new browser tab [> Print Parent Letter:

| Print Parent Letter |

Letter for Miller Kenshaw 08/06/2020

6" Grade, Assessment 1

Sand Park Junior High School

Dear Parent(s):

As Miller's reading teacher this year, | want to let you know about one of the
many things we will do to help him become a better reader. Our school uses the
Florida Assessments for Instruction in Reading-Florida Standards (FAIR-FS) to
ensure that all of our students are receiving reading instruction that will improve
their reading skills, and meet the Language Arts Florida Standards (LAFS). The
FAIR-FS is administered at the beginning, middle, and end of the school year to
monitor progress. We use the FAIR-FS because it is a reliable and valid measure of
the important teachable skills in reading (i.e., decoding, oral language, and
reading comprehension) that affect overall academic performance. We use the
results of the FAIR-FS to ensure that Miller's reading skills are developing at an
appropriate rate. We also want to know which skills we can target in the
classroom and at home for him to become a successful reader. For each skill that
was assessed, two scores are provided:

Ability Score: This score provides an estimate of the level of a student's ability
in a particular skill and detects changes as a student's ability with the skill
increases or decreases. The range of scores is 200 to 1000. For example, if a
student gains more than 100 points over the school year, he made significant
growth.

Percentile Rank: This score is used to rank a student's performance in relation

to other students in 6™ grade. The range of scores is from 1-99 (25 through
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Create WAM Student Ability Score Reports

1. PMRN Home [> SCHOOL Functions tile > Student Reports tab
2. Select Year [> School > Grade [> Student [> WAM Student Ability Score Reports:

Reports
2020-2021 »
Sand Park Junior High School v

Gih W

KOLLINS. JARED  w

Report Description

WAM Parent Letter Generate parent |etter for current year.
WAM Student Ability Score Reports I Generate 3-12 WAM Student Ability Score Reports for multiple years.
WaAM Student Report Generate 3-12 WAM Student Report for current year
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3. Report window launches to show up to three years of the FAIR-FS assessment results
including PLS and individual task scores for each AP within each year. Median task scores
for the year and AP are noted by a horizontal line within each shaded bar:

R
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4. Print Student Report.
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Create WAM Student Report

1. PMRN Home [> SCHOOL Functions tile > Student Reports tab

2. Select Year > School [> Grade [> Student [> WAM Student Report:

2020-2021 »
Sand Park Junior High School v

Gih W

KOLLINS. JARED  w

WAM Parent Letter
WAM Student Ability Score Reports
WAM Student Report

Generate parent letter for current year.

Generate 3-12 WAM Student Ability Score Reports for multiple years.

Generate 3-12 WAM Student Report for current year

3. Report window launches. The WAM Student Report displays the FAIR-FS assessment
results for the selected AP. This report displays AP, Grade, Student Name, FLEID, date and
time of assessment, Percentile Ranks, Task Ability Scores, PLS and Open Response Task

information if administered:

Assessment Period:
FAIR-FS Student Report (3-12)

Print Studgnt Report

School Year: 2020-2021
Assessment Period: 1
Grade: 6

Student: Jared Kollins
FLEID: TDO0O0000715249

WRT 712412020 12:04:25 PM
VKT 7/24/2020 12:05:27 PM
RCT 7/24/2020 12:07:30 PM

Student Report Legend

Below indicates the time when the student completed each task
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4. Print Student Report.
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Location: For District Access Levels:
SCHOOL Functions > Users District Administrator

District Designee

ViewCurrentUserlist ...

1. PMRN Home [> SCHOOL Functions tile [> Users tab
2. Select School:

e Sort by clicking on column header:
O User name
O Access Level

e Filter by drop-down list selection:

0 Access Level Missing — user is in your list, which means Location is correct in SSO,
but the user has no current access levels

O Ready to Access PMRN — user Location and access levels specified, ready to go!

0 SSO Credentials Missing — user SSO setup is in some way incomplete — contact your
District SSO Portal Admin and/or IEN Help Desk (or via phone at 855-814-2876);
possibilities:

= User has a duplicate ID

= User has only one ID, but SSO Location setting is incorrect (user most likely
maintains the correct level of access at old location)

=  User SSO Location setting has failed to update to central SSO
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Modify School User Access Level

3. Userstab [> Choose User > Review ID, First Name, Last Name, Email and Access Level:

School Teacher Class Student Classes/  Students  Survey Access
Reports  Reports Reports  Reports Periods Status WAM Key
PMRN Unique ID B7CA4PE2A
Identifier * e
First Name * Yolanda
Last Name * Carter
E-mail * Yolanda Carter@fldoesandpark org
Access
Allow? Access Level Access to PMRN
] Assessment Team Member
] Reading Teacher
I O Resource Teacher O I
] School Administrator
School Designee
School Reports User
Submit | | Cancel |
* Denotes required fields.

4. To modify:

a. Check box(es) to add access or Uncheck box(es) to remove access under Allow?

b. Submit > “You have changed this User’s information. Please verify that the
information below is correct.” message appears [> Review and Continue

o

“User information was updated successfully.” message confirms.

d. Verify in the Users tab listing.

Note: A single access level must have both Allow? and Access to PMRN checked in
order to enable the PMRN system user. Think of the Access to PMRN setting as an
SSO setting, i.e., “Is this user enabled at SSO to be a Resource Teacher in the PMRN?”
and Allow? as a “This PMRN user will be allowed to use this access level” setting.

If one is checked and one isn’t as in the case of School Administrator above, we often
liken it to a person with a car and a driver’s license (Access) who may (usually
temporarily) not be allowed to drive (Allow?). Checking both boxes empowers the
user at that access level.

P M R N Progress Monitoring & Reporting Network v5.1 — District User Guide 75



Location:

SCHOOL Functions [> Classes/Periods

For District Access Levels:
District Administrator
District Designee

Each reading teacher and resource teacher in the PMRN system is displayed on the Classes/Periods
tab. District and school administrators and designees may add class periods for each of the teachers
listed. Students must be added to a class period in order to be assessed.

View Current Class Period List

1. PMRN Home [> SCHOOL Functions tile
2. Select School > Classes/Periods tab:

School  Teacher Class Student

Reports Reports Reports Reports

"Delete Class/Period” link.

Users Wo-TT-T7M | Students

Periods

To add a class/period, select the "Add Class/Period” link for a teacher.

Access

WAM Key

To delete a class/period, remove all students from the class/period (a class/period with student enrollment cannot be deleted). Then, select the

Teacher Type Class/ Period Student Count
Carter, Yolanda Reading 06 - Carter, Yolanda 7

Add Class/Period
Carter, Yolanda Reading 06 - Carter, Yolanda 8
Carter, Yolanda Reading 07 - Carter, Yolanda 9

Add Class/Period
Carter, Yolanda Reading 07 - Carter, Yolanda 5
Carter, Yolanda Resource Add Class/Period

Teacher Type Class/Period Student Count
Carter, Yolanda Reading 06 - Carter, Yolanda 7

Add Class/Period
Carter, Yolanda Reading 06 - Carter, Yolanda 8
Carter, Yolanda Reading 07 - Carter, Yolanda 9

Add Class/Period
Carter, Yolanda Reading 07 - Carter, Yolanda 5
Carter, Yolanda Resource Add Class/Period
Mccabe, Peter Reading I —————————————————————— - I Add Class/Period I
Orsi, Joyce Reading 08 - Orsi, Joyce - A 11 \\

Reading 08 - Orsi, Joyce - U 3
Add Class/Period
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Choose Class Type > Teacher [> Grade [> Periods designation(s) [> Submit:

Classes/
Periods

Add Class/Period

Select the class type, teacher name and grade from the drop down lists and click Submit.

Note: Periods may be used to distinguish classes from each other as needed. The "U" period is the default selection for "unassigned."

Class Type:

Teacher: | Mccabe, Peter ~ |

Grade:

Periods: Oa OB Oc Op O OF O OH u

| submit Cancel |

______ =
>

5. Edit Class/Period page opens.

a.

Continue to Add a Student to a Class Period instructions to populate a class, or

b. Select Classes/Periods tab to review or repeat steps 3-4 to add more class periods
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Add a Student to a Class Period

1. From the Classes/Periods tab [> Select the Class/Period to which you would like to add

students:
Teacher Type Class/Period Student Count
Carter, Yolanda Reading 06 - Carter, Yolanda 7
Add Class/Period
Carter, Yolanda Reading 06 - Carter, Yolanda 8
Carter, Yolanda Reading 07 - Carter, Yolanda
Add Class/Period
Carter, Yolanda Reading 07 - Carter, Yolanda 5
Carter, Yolanda Resource Add Class/Period
Mccabe, Peter Reading | 08 - Mccabe, Peter - U | 0 Delete Class/Period
Add Class/Period
Orsi, Joyce Reading 08 - Orsi, Joyce - A 11
Reading 08 - Orsi, Joyce - U 3
Add Class/Period

2. From Edit Class/Period page [> Add Student to Class:

School  Teacher Class Student | Users NWETI=-C78 | Students  Survey Access
Reports  Reports Reports Reports. Periods Status WAM Key

Edit Class/Period

CLASS: 08 - Mccabe, Peter GRADE: 8th TEACHER: Mccabe, Peter Student Count: 0

View Class: |08 - Mccabe, Peter v |  Period:

Class Roster:
To add or remove students from the class roster or to change the period for a student, click the buttons below.

There are no students in this Class.
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3. Search for Students:

Classes/
Periods

Add Student to Class

Return To Class Roster

CLASS: 08 - Mccabe, Peter GRADE: 8th TEACHER: Mccabe, Peter STUDENT COUNT: 0

Search for students in 8th grade by either clicking Show All, a letter under Student Directory Search, or entering a student's name in the Last

Name Search field.

Student Directory Search Last Name Search

a. Show All - View a list of all currently enrolled Class/Period Grade students
b. Student Directory Search — Select first letter of Last Name

c. Last Name Search — Enter Last Name [> Search
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5. Results load below search (Show All results below). Note the left-most column indicating
current class/period status:

Class Roster:
Students with a checkmark are currently assigned to this teacher. To add students to this teacher, check the box next to their Identifier, indicate
the pericd in the drop down (if more than one period is available) and click Submit. To remove students from this teacher, uncheck the box and
click Ssubmit. To enroll a new student in the school and class, click the Enroll Student button.
Note: An ¥ indicates that the student is assigned to ancther teacher's class roster. To be assigned to this class, the student must first be
removed from the other class.

“Enroll Stucent | submit

FLEID Last Name First Name Birthdate Grade Period

® TDO0O0002261073 Gaines Niel 7/29/2006 08

# TDO00001649267 Gainesborough Leola 1/21/2007 08

® TDOO0001649271 Gardin Nicholas 8/20/2007 08

[m] TDO00001036172 Gerard Theo 9/12/2007 08

® TDOODOD01649268 Giard Lee 6/11/2007 08

® TDOO0002027172 Glaster Taylor 9/6/2006 08

TDO0OD001649269 Gohm Leigh 5/11/2007 08

TD0O0OD001649270 Grady Alison 4/22/2007 08

O TDO00D04223065 O'shaunnessey Paul 11/26/2006 08

® TDO0O0000863302 Picup Samantha 6/7/2007 08

® TDOODOO0750201 Porcester Teresa 5/24/2007 08

O TDOOD000862201 Porter Peter 12/4/2006 08

O TDOOD0OO0710345 Praktik vinda 9/7/2007 08

® TD0O0O0000140388 Student A 1/1/2007 08

® TDOOD0OO0160377 Student AA 1/1/2007 08

® TDO0O0000130398 Student Aaa 1/1/2007 08

“Enrol Student [ submit

a. ¥ Currently assigned to this teacher
i.  Use Period drop-down to assign to a different class/period
b. * Currently assigned to another teacher

i.  Remove from current teacher’s classpperiod prior to add, see Remove a Student
from a Class Period instructions

C. Not currently assigned

i. Select "' box(es) to the left of student FLEID(s) you wish to add [> Select Period
> Submit

ii. “Student(s) added to class successfully.” message confirms [> Student count
updates > Return to Class Roster.
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Remove a Student from a Class Period

1. On the Classes/Periods tab [> Select the Class/Period from which you would like to
remove students:

Teacher Type Class/Period Student Count
Carter, Yolanda Reading 06 - Carter, Yolanda 7

Add Class/Period
Carter, Yolanda Reading 06 - Carter, Yolanda 8
Carter, Yolanda Reading 07 - Carter, Yolanda 9

Add Class/Period
Carter, Yolanda Reading 07 - Carter, Yolanda 5
Carter, Yolanda Resource Add Class/Period
Mccabe, Peter Reading I 08 - Mccabe, Peter - U I 5

Add Class/Period

2. From Edit Class/Period page > Remove Student from Class:

School  Teacher Class Student Users WeFTEHFS  Students | Survey Access
Reports Reports Reports  Reports Periods Status  WAM Key

Edit Class/Period

CLASS: 08 - Mccabe, Peter GRADE: 8th TEACHER: Mccabe, Peter Student Count: 5

View Class: [08 - Mccabe, Peler ~|  Period:

Class Roster:
To add or remove students from the class roster or to change the pericd for a student, click the buttons below.

Add Student to Class Remove Student from Class

Last Name First Name Gender Birthdate
1 TDO0DO001645269 Gohm Leigh F 5/11/2007
2 TDO00001645270 Grady Alison F 4/22/2007
3 TDO0O0004223065 O'shaunnessey Paul M 11/26/2006
4 TDO00000862201 Porter Peter M 12/4/20086
5 TDOD0O000710345 Praktik Vinda F S/7/2007

| Submit | | cancal |
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3.

4.

-—=p
-—=p

5.
6.

Current roster loads:

Remove Student from Class

Return to Class Roster
CLASS: 08 - Mccabe, Peter GRADE: 8th TEACHER: Mccabe, Peter STUDENT COUNT: 5

Class Roster:
Students with a checkmark are currently assigned to this teacher's class. To remove students from this class, uncheck the box next to their
Identifier and click Submit.

| Submit

In Class FLEID Last Name First Name Birthdate Grade
TDO00001645269 Gohm Leigh 5/11/2007 8th
TDO00D001645270 Grady Alison 4/22/2007 8th
TDO0O0004223065 O'shaunnessey Paul 11/26/2006 8th
TDOO0000862201 Porter Peter 12/4/2006 8th
TDO00000710345 Praktik Vinda 9/7/2007 8th
Submit |

All show as  Currently assigned to this teacher

Uncheck In Class box(es) of students you wish to remove > Submit:

Remove Student from Class

Return to Class Roster
CLASS: 08 - Mccabe, Peter GRADE: 8th TEACHER: Mccabe, Peter STUDENT COUNT: 5

Class Roster:

Students with a checkmark are currently assigned to this teacher's class. To remove students from this class, uncheck the box next to their
Identifier and click Submit.

Submit
In Class FLEID Last Name First Name Birthdate Grade
TDOO0OOD164526% Gohm Leigh 5/11/2007 8th
TDOO0O0D1645270 Grady Alison 4/22/2007 8th
(] TDO00004223065 O'shaunnessey Paul 11/26/2006 8th
] TDO0O00D0862201 Porter Peter 12/4/2006 8th
TDOOOODO710345 Praktik Vinda 9/7/2007 8th
Submit :

“Student(s) removed successfully.” message confirms [> Student count updates

Return to Class Roster.

P M R N Progress Monitoring & Reporting Network v5.1 — District User Guide

82



Move Class Roster(s)

If a teacher has multiple class periods, moving a class roster from that teacher moves all class periods
from that teacher. To move only one class period from one teacher to another, use Remove Student
from Class instructions, immediately followed by Add Student to Class instructions.

To move all class periods from one teacher to another:

1. Onthe Classes/Periods tab [> Select the Class/Period to be moved to another teacher:

Teacher Type Class/Period Student Count

Dagostini, Kimberly Resource Add Class/Period
Dougherty, Alan Reading Add Class/Peried
Harner, Keith Reading Add Class/Period
Wade, Theresa Aka Reading 03 - Wade, Theresa Aka Tee - A 4

Tee Reading I 03 - Wade, Theresa Aka Tee - U 5|

Add Class/Peried

Wilkey, Chris Reading 03 - Wilkey, Chris - U 4

Add Class/Period
Wilkey, Chris Reading 04 - Wilkey, Chris - U 11

Add Class/Period
Wilkey, Chris Reading 05 - Wilkey, Chris - U 10

Add Class/Peried

2. In the Move Class Roster section, select Move Class to teacher [> Submit

Move Class Roster:

Select an eligible teacher from the drop down and click Submit to move all class rosters to another teacher.

Submit Cancel

Move Class From: Wade, Theresa Aka Move Class to:
Tee

a. Only teachers without existing class/periods appear in the Move Class To drop-down.
To move students to a teacher with existing classes, remove them from the current
class period, then add.

3. “The class has been successfully updated.” message confirms move

4. Updated class roster for new class period displays > Review Classes/Periods tab to
confirm.
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Delete a Class Period

Only class periods with no students may be deleted. Once all students are removed from a class period,
the Delete Class/Period link appears.

1. PMRN Home [> SCHOOL Functions tile > Classes/Periods tab
2. Select a School

3. Locate Teacher [> Find class/period [> Delete Class/Period:

Teacher Type Class/Period Student Count
Mccabe, Peter Reading 08 - Mccabe, Peter - U 3
Add Class/Period
Orsi, Joyce Reading 08 - Orsi, Joyce - A A
Reading 08 - Orsi, Joyce - B ( 0 ) ------ | Delete Class/period |
Reading 08 - Orsi, Joyce - U
Add Class/Period
Pilly, Polly Reading 06 - Pilly, Polly - A 0 Delete Class/Period
Reading 06 - Pilly, Polly - B 0 Delete Class/Period

4. “Period was successfully deleted.” message confirms.
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Location: For District Access Levels:
SCHOOL Functions > Students District Administrator
District Designee

1. PMRN Home [> SCHOOL Functions tile [> Students tab
2. Select a School

3. Choose a grade level > Show All:

School  Teacher Class Student | Users | Classes/ RETIEICN | Survey Access
Reports Reports Reports  Reports Periods Status  WAM Key

Search for Students in the School

1. Select the grade of the student you wish to find.

Show students in | 6th Grade A

2. Locate students in your school by either clicking a letter under Student Directory Search or entering a student’'s name in the Last Name Search field.

Student Directory Search Last Name Search
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4. Results display at bottom:

Enroll a Student | Withdraw Selected Students :
Withdraw Student FLEID Last Name First Name Birthdate Gender Grade Period

O TDO00D007260933 Jalopnik Trinity 11/19/2008 F 6th 06 - Carter, Yolanda
(] Jeffries 0Oshea 5/8/2009 F 6th 06 - Carter, Yolanda
O Jenkins Harley 11/12/2009 F 6th 06 - Carter, Yelanda
(] Jonas Miracle 6/9/2009 F 6th 06 - Carter, Yolanda
O Jones Charles 3/10/2009 M 6th 06 - Carter, Yolanda
O TDO00008042246 Kelleher Henry 8/23/2008 M 6th 06 - Carter, Yolanda
O TDO0D000D880565 Kelly George 9/12/2008 M 6th 06 - Carter, Yolanda
O TDO00008043346 Kennedy Arthur 10/10/2008 M 6th 06 - Carter, Yelanda
O Kenshaw Miller 8/19/2009 M 6th 06 - Carter, Yolanda
[m] TDO00000767291 Kilharn Maon 12/21/2008 F 6th 06 - Carter, Yolanda
O TDODOOO0715249 Kollins Jared 2/24/2009 M 6th 06 - Carter, Yolanda
(] TD000000352131 Patrick Alan 4/1/2009 M 6th 06 - Carter, Yolanda
O TDO0OD00D0D273411 Patterscn Sian 9/9/2009 F 6th 06 - Carter, Yolanda
(] TD0O00000262421 Stewart Ad 3/17/2009 M 6th 06 - Carter, Yolanda
O TDO00000865630 Taylor Petra 1/10/2009 F 6th 06 - Carter, Yolanda
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Search the Student Directory

1. PMRN Home [> SCHOOL Functions tile [> Students tab

2. Select a School

3. Choose Student Directory Search or Last Name Search:

School  Teacher Class Student | | Users | Classes/ [T G o0 | Survey Access
Reports  Reports Reports  Reports Periods Status  WAM Key

Search for Students in the School

1. Select the grade of the student you wish to find.
Show students in | 6th Grade v

2. Locate students in your school by either clicking a letter under Student Directory Search or entering a student’'s name in the Last Name Search field.

Student Directory Search Last Name Search

| showaul | AB|CDEE|GH|I|J KL M

| Enroll a Student | Withdraw Selected Students
Withdraw Student FLEID Last Name First Name Birthdate Gender Grade  Period

O TDO00000352131 Patrick Alan 4/1/2009 M &th 06 - Carter, Yolanda

O TD000000273411 Patterson Sian 9/9/2009 F &th 06 - Carter, Yolanda

a. Student Directory Search — Select first letter of Last Name

b. Last Name Search — Enter Last Name [> Search

4. Results load below search.

Note: Using Student Directory Search options in combination is an easy way to
quickly narrow your search results in large datasets, e.g., 6" Grade students with last
names starting with Pa as shown in the screen shot!

For large schools especially, remember that when we search for anything these days,
we are specific by default. If you're looking to make lunch plans, your search is never
just restaurant. It's seafood lunch restaurant near me or vegan takeout near 2™

Avenue.
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Enroll a Student

1. PMRN Home [> SCHOOL Functions tile [> Students tab
2. Select a School
3. Enroll a Student:

School  Teacher Class Student | | Users | | Classes/ | =11 =158 | Survey Access
Reports  Reports Reports  Reports Periods Status  WAM Key

Search for Students in the School

1. Select the grade of the student you wish to find.

Show students in [All Grades v

2. Locate students in your school by either clicking a letter under Student Directory Search or entering a student's name in the Last Name Search field.

Student Directory Search Last Name Search

L 1 Search
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Enroll a Student Withdraw Selected Students

N>

4. Enter FLEID or First Name, Last Name and Birthdate [> Search:

School  Teacher Class Student | Users | | Classes/ Q=M PE1ITH | Survey Access
Reports Reporis  Reports  Reports Periods. Status  WAM Key

PMRN Database Search

Search By:
FLEID or First Name Last Name Birthdate
(14 digits) (MM/DD/YYYY)

| diana | [brooke | 12122006 |

Search | | Cancel |

5. Review results > Select radio button under Select column > Next:

The students already in the PMRN database that closely match the information you entered are listed below. Select the student that you would
like to attempt to add.

Last Name

TDOO0001297837 Diana Brooke 12/12/2006 F 7th @
O I want to enroll 3 new student.

Next :
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6. Review and/or update Grade information as needed > Enroll in School:

Enroll Student in School

Verify the grade for the student

FLEID TDO00001297837
First Name Diana
Middle Name
Last Name Brooke
Birthdate 12/12/2006
Grade
Gender F
[ Enroll in School Cancel
l/\\\)

7. “Student enrolled successfully.” message confirms and you are returned to the Students
tab.

Note: Only use the | want to enroll a new student radio button on the left if your
search yields no matching results! If a student has an ID, but is enrolled again,
duplicates are created and (most importantly) assessment history is split.
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Withdraw a Student

4.

5.

PMRN Home [> SCHOOL Functions tile [> Students tab

Select a School

Using Grade search, Directory and/or Last Name search, locate student(s) you wish to
withdraw [> Select corresponding Withdraw Student checkbox(es) [> Withdraw
Selected Students:

School  Teacher  Class  Student Users Classes/ [0 010l Survey — Access
Reporis Reports  Reporis  Reports Periods Status  WAM Key

Search for Students in the School

1. Select the grade of the student you wish to find.

Show students in | All Grades v

2. Locate students in your school by either clicking a letter under Student Directory Search or entering a student's name in the Last Name Search field.

Student Directory Search Last Name Search
AECDEEGHI|JKLM seereh
NOPIQRSTUV|WXYZ

Enroll a Student . Withdraw Selected Students

Withdraw Student Last Name First Name Birthdate Grade

TDO00001257837 Brooke Diana 12/12/2006 F 7th

Gender

Period

“You have asked to withdraw students.” message appears [> Verify and Continue:

o You have asked to withdraw students.

Selected students for withdrawal:

FLEID Last Name First Name Birthdate Gender Grade

TDO00001297837 Brooke Diana 12/12/2006 F 7th

If you continue, the data will not be retrievable. Are you sure that you want to continue?

Continue Cancel

“Student(s) withdrawn successfully.” message confirms.
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Review Student Attributes

PMRN Home [> SCHOOL Functions tile [> Students tab
Select a School

(Optional) Select a Grade

S

Search for enrolled students:

School  Teacher Class Student | | Users | Classes/ [T G o0 | Survey Access
Reports  Reports  Reports  Reports Periods Status  WAM Key

Search for Students in the School

1. Select the grade of the student you wish to find.

Show students ir] | 6th Grade v

2. Locate students in your school by either clicking a letter under Student Directory Search or entering a student's name in the Last Name Search field.

Student Directory Search Last Name Search
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| Enroll a Student Withdraw Selected Students
Withdraw Student FLEID Last Name First Name Birthdate Gender Grade Period
O TDO00000352131 Patrick Alan 4/1/2009 M 6th 06 - Carter, Yolanda
O TD000000273411 Patterson Sian 9/9/2009 F &th 06 - Carter, Yolanda

a. Show All - View a list of all currently enrolled students
b. Student Directory Search — Select first letter of Last Name
c. Last Name Search — Enter (full or partial) Last Name [> Search

5. Results load below search > Select Last Name to view student information:

Withdraw Student FLEID Last Name First Name Birthdate Gender Grade Period
=] TD000000352131  Patrick Alan 4/1/2009 M 6th 06 - Carter, Yolanda
0 TDO00000273411 Sian 9/9/2009 F 6th 06 - Carter, Yolanda

W
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Update Student Attributes

6. Within the student record:

School  Teacher Class Student | Users @ Classes/ R=iT - ol @ Survey Access
Reports  Reports  Reports  Reports Periods Status  WAM Key

Student Information

Student Attributes

PMRN ID 9117382

FLEID * TDO00000273411

First Name* [sian |

Middle Name [ |

Lest tleme? [Patierson ‘ District users may edit
-

Gender

Modified Task Flow

Eligible

* Required fields (" Update | cancel |

School Year Calendar Na.ne Current Grade Change Grade To
2020-2021 Sand Park Junior High School - District-Wide 06

[ ]

[

(05|

a. Student Attributes — Review information [> Edit as needed [> Update

Change Student Grade Level

b. Grade Level - Select Grade level [> Change > “You have selected to change this
Student’s grade to grade <#>. Click Continue to confirm.” message confirms selection
> Continue

7. Student Information page appears with updated information.
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Modified Task Flow

Students identified in Survey data as Deaf or Hard of Hearing or Dual-Sensory Impaired are eligible for

modified task flow in the PMRN system. However, there may be a delay between when the Survey data
is provided and when the student takes the FAIR-FS assessment. Therefore, there is a manual two-step
process for identifying and selecting students for modified task flow within the PMRN:

STEP 1 — District Administrator or District Designee identifies the student for modified task flow

STEP 2 — School Administrator or School Designee selects the student for modified task flow

Location: For District Access Levels:
SCHOOL Functions [> Students District Administrator or District Designee

Identify Students for Modified Task Flow

1. PMRN Home [> SCHOOL Functions tile [> Students tab
2. Select a School

3. (Optional) Select Grade level [> Select first letter of Last Name or enter student Last Name
> Search

4. Select Last Name to open student record:

| Enroll a Student | Withdraw Selected Students
Withdraw Student FLEID Last Name First Name Birthdate Gender Grade Period
O TDO000D00352131 Patrick Alan 4/1/2009 M 6th 06 - Carter, Yolanda

O TDO00000273411 Sian 9/9/2009 F 6th 06 - Carter, Yolanda

W
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5. Select the appropriate ESE indicator from the Modified Task Flow Eligible drop-down [>
Update:

Student Information

Student Attributes

PMRN ID 9117382

FLEID * TDO00000273411

First Name* [sian |
Middle Name [ |
Last Name* [Patterson |
Gender [E ]

Modified Task Flow
Eligible

* Required fields Update l &= |

School Year Calendar hame Current Grade Change Grade To

2020-2021 Sand Park Junior High School - District-Wide 06 .

6. “Student updated successfully.” message confirms.
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Location: For District Access Levels:
SCHOOL Functions [> Survey Status District Administrator

District Designee

Review Current Import Information

1. PMRN Home [> SCHOOL Functions tile [> Survey Status tab
2. Select a School
3. Survey 8 Import Information detail displays:

a. If Survey 8 data has not been received and imported:

School Functions

District: school Year:

School: [Sand Park Junior High School 990361 ~ |

School  Teacher Class Student  Users  Classes/  Students Access
Reports  Reports  Reports  Reports Pericds WAM Key

No Survey imports have been received for this School/School Year.

b. If Survey 8 data has been received and imported:

Note: Survey 8 data submitted by the school district automatically populates class
rosters and student data in the PMRN system. 2020-2021 Survey dates are:

B Thursday DUE DATES (by 4:00 p.m. EST) starting July 23, 2020 ending September
24,2020

Friday DATA IMPORT TO THE PMRN SYSTEM (PMRN offline Friday evenings for
import)

B Monday DATA AVAILABLE IN THE PMRN SYSTEM
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Search the Import for a Student

4. Inthe Student Details section of the Survey Status tab:

a. Enter at least two letters of Student Last Name

b. Enter at least two letters of Student First Name (optional)

c. Search:

Student Details

Enter at least two letters for the student's last name and click Search.

Student Last Name Student First Name (opticenal): l:l

Search
Last Name First Name Birthdate Gender Grade Teacher's Name Action Taken Rostel
CABELLO CALISTA 01/01/2008 F 5 CHRIS WILKEY Updated Yes
CALDRY ANNA 01/01/2010 F 3 THERESA WADE Updated Mo

Search the Import for a Teacher

5. Inthe Teacher Details section of the Survey Status tab:

a. Enter at least two letters of Teacher Last Name

b. Search:

Teacher Details

Enter at least two letters for the teacher's last name and click Search.

Teacher Last Namel ma I

Last Name First Name PMRMN Unique ID Action Taken
MABRY ALEXANDRA Mone
MASSIMO SUSAN

Mone
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Location: For District Access Levels:
SCHOOL Functions [> Access WAM Key District Administrator
District Designee

Access WAM Key

1. PMRN Home > SCHOOL Functions tile > Access WAM Key tab
2. Select a School

3. Today’s Assessment Key is provided:
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CONCLUSION

The Progress Monitoring & Reporting Network (PMRN) provides an opportunity for administrators,
teachers, students and others to monitor students’ progress in reading within the current school year
and across multiple school years. The FAIR-FS data provides individual student reports and parent
letters and summary class, teacher, grade-level and school reports. The data generated may be utilized
to monitor and tailor instruction to meet students’ specific reading needs.

The PMRN District and School User Guides provide an overview and daily reference for FAIR-FS
assessment-related activities. All online PMRN resources are available from the Resources link within
the PMRN navigation menu:

Access via direct link on the Just Read, Florida! page at
http://www.fldoe.org/academics/standards/just-read-fl/fair/public-school.stml.

As always, District- and School-level users may contact the Help Desk at IENHelp@fldoe.org or (Toll
Free) 855-814-2876 for your PMRN support needs.
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CONTACT INFORMATION

Just Read, Florida!

325 West Gaines Street, Suite 1432

Tallahassee, Florida 32399-0400

On the web: http://www.fldoe.org/academics/standards/just-read-fl/
Email: JustRead@fldoe.org

Telephone: 850-245-0503

Fax: 850-245-5105

Contact: Amy Hand

Just Read, Florida!

FAIR-FS Tier 2 Support
Telephone: 850-245-7876
Email: amy.hand@fldoe.org

FDOE Help Desk (District and School Users)

Email: IENHelp@fldoe.org
Telephone (Toll Free): 855-814-2876

Please note that there is no direct support path for students to IENHelp.

Note: Help for District- and School-Level Users vs. Parents and Students @Home

If a student is completing the FAIR-FS at home and encounters difficulties, he or she
should contact the school first. If the school contact cannot solve the issue and then

needs to email or call IENHelp, then the school contact may do so as normal.
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